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How to access MadeToPrint 
MadeToPrint can be started from the File menu in QXP. Start-
ing MadeToPrint for the first time, you will have the option to 
install sample MadeToPrint Output Jobs giving you an idea 
about how MadeToPrint Output Jobs looks like. 

Application – Access and run MadeToPrint XT How to access MadeToPrint
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The Run Mode 

 The Run Mode of MadeToPrint lists up all defined 
Output Jobs and Job Sets, which can be applied 
with a simple mouse click to the currently open 
QXP document. 
A batch processing feature allows for MadeToPrint 
Output Jobs to be applied to several QXP docu-
ments in one go. 

Choosing the MadeToPrint entry from the File menu will acti-
vate the Run Mode. The Output Jobs or Job Sets which have 
been configured can be applied to the current document by 
clicking on the Run button. 

Furthermore, the number of copies can be specified for print 
output and page ranges can be defined. The pop up menu 
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within the Run Mode displays the different modes of process-
ing documents. 

Process current document:Process current document: Carries out the selected setting or 
set on the currently opened document. 
Process all open documents:Process all open documents: Carries out the selected setting 
or set on all currently opened documents one by one. 
Process folder:Process folder: allows batch processing specific folders with 
all QXP documents inside. 
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MadeToPrint Edit Mode 

 This mode provides all tools to create and edit Out-
put Jobs as well as the option to combine several 
Output Jobs into a Job Set in order to carry them 
out simultaneously. 

The Edit Mode is divided into three parts. On the left you find 
a column listing up Output Jobs and Job Sets. The middle 
column lists up the different groups of options. The right area 
displays the options that are available for adjusting the Out-
put Job. 

Four buttons above the left column enable users to create, to 
duplicate and to delete Output Jobs or Job Sets. 

In the lower part of the Edit box you find three buttons for ad-
dressing MadeToPrint: 

Setting up Output Jobs and Job Sets MadeToPrint Edit Mode
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– save settings without closing box (ApplyApply) 
– return to the last saved version (RevertRevert) 
– save and close box (CloseClose) 

Setting up Output Jobs and Job Sets MadeToPrint Edit Mode
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“General” Options 

Following options for general details are available: 

Name:Name: For specifying a Output Job name. 
ActiveActive: Untick the check box for disabling the Output Job 
within Run Mode. 
Locked:Locked: Modifications to locked Output Jobs cannot be 
saved. 
Rating:Rating: Output Jobs and Job Sets can be rated. 
Comment:Comment: You may enter a comment to each Output Job, 
which is displayed in the Run Mode, when the Output Job is 
selected. 

 We recommend you to use the comment field to 
note a meaningful descriptionmeaningful description of each Output Job. 
This description will also be shown in the represen-
tation of the list in Run Mode. 
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“Output” Options 

In the Output section, from the drop-down menu you can se-
lect if the Output Job is to apply to PostScript output on a 
printer or to file output. For file output the formats Post-
Script, EPS, PDF,  Collect for Output and QXP/QPT document 
are available. 

By ticking on the Setup… button, you reach a context-sensi-
tive dialogue window for "Collect for Output" and "Save as 
Document". Here you can determine what is to be collected 
and select the file type QXP or QXP template for the output. 

Setting up Output Jobs and Job Sets “Output” Options
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MadeToPrint XT supports the output styles of Quark. The Out-
put Styles can be found in the Edit menu. As a result, all spe-
cific output adjustments have be determined within Quark 
and be addressed afterwards by MadeToPrint. 

By ticking the Checkbox under Pages, MadeToPrint will adopt 
the size of  the QXP documents and create output files of ex-
actly the same size. 
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 The SummarySummary field allows an overview of the cur-
rent settings. 
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“Distiller” Options 
This option allows you to create PDF files via PostScript and 
Acrobat Distiller. The installation of Acrobat Distiller is re-
quired. After having defined the path to Acrobat Distiller, all 
Adobe PDF settings available for conversion appear in a pop-
up menu. Furthermore, you can keep or delete the PostScript 
and the log files. 
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“File Name” Options 

 File and folder names can be determined by tokens 
(variables). A description on how to use these vari-
ables can be found in the Token HelpToken Help. 

In this area, you can specify the destination folder and file 
names for file output. MadeToPrint supplies a highly flexible 
tool for rule-based creation of file names and destination 
folders. For print output, these options are not available. 

How to Define Destination Folders How to Define Destination Folders 

• To save output files next to the current InDesign docu-
ment, activate the check box Use path of current docu-
ment/book. 

• Optionally, click the Choose… button to select a destina-
tion folder. 
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• You can define a fix path or define rules that determine 
the destination path during Output Job run time. To de-
fine such a rule you can choose between various tokens. 

• A preview of the path will be displayed in case the token is 
used properly. 

How to define file names How to define file names 

• To use the document name for the output file please acti-
vate the check box Use name of current document/book. 

• A wide range of tokens is available for flexible output file 
naming. In connection with the single page output op-
tion, the token DOCUMENTNAME() can be combined with 
the token PAGENUMBER() to add the respective page 
number to the file name. 

• The check box Overwrite Output File defines whether the 
existing files are to be overwritten or to be indexed. 

Setting up Output Jobs and Job Sets “File Name” Options

MadeToPrint for QuarkXPress Manual 21



Token sequences/Token Editor 
Even complex rules can be set up, edited and administrated 
conveniently via the Token Editor. The list of Token Se-
quences is available as a dropdown menu wherever Tokens 
are used in MadeToPrint. 

Press the button Edit Token Sequences to set up and admin-
istrate even complex rules with the Token Editor. Available 
Token Sequences are listed up in a pulldown menu. 

 The use of tokens is not restricted to a single entry. 
You can create Token sequences that are made up 
of different tokens as well as static text. The Token 
Editor of MadeToPrint (Button: Edit Token Se-
quences) allows you to create, check and save To-
ken sequences in order to use them in different set-
tings. 

Setting up Output Jobs and Job Sets Token sequences/Token Editor
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“Page” Option (Single Page Output) 
In this area, you can predefine the output of PS/EPS/PDF doc-
uments as single pages. Enable the checkbox for a single 
page output. By default, this checkbox is not activated, for 
EPS output it is generally activated. 

Setting up Output Jobs and Job Sets “Page” Option (Single Page Output)
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“Layer” Options 
MadeToPrint is able to manage layers in InDesign documents 
flexibly. Using the Layer option, document layers can be out-
put in different combinations: 

• Output all visible layersOutput all visible layers (WYSIWYG) 
• Output all layersOutput all layers (output all existing layers on one page) 
• Output every visible layer separatelyOutput every visible layer separately (output every visible 

layer on a separate page) 
• Output every layer separatelyOutput every layer separately (output every existing layer 

on a separate page) 
• Output layer combinationOutput layer combination (output fix and variable layers) 

The option Output layer combinationOutput layer combination enables users to select 
layers and combine them to different output combinations. 
Certain layers can be kept, others can be discarded. 

Example: Multi-lingual document Example: Multi-lingual document 

Setting up Output Jobs and Job Sets “Layer” Options
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Your  document contains the layers background and pictures 
as fix layers. Additional layers are assigned to text in different 
languages (per document layer). 

How do I set up my Output Job? How do I set up my Output Job? 

• The category Fix Layers contains layers for background 
and pictures 

Setting up Output Jobs and Job Sets “Layer” Options
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• The category Per Document Layers contains the layers 
text_eng, text_french, text_ger 

The result will be three output files each containing a differ-
ent language version. 

 To include the name of layers within the file name, 
the Tokens Layer NameLayer Name and Layer NumberLayer Number can be 
used. 

Setting up Output Jobs and Job Sets “Layer” Options
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“Infobar” Options 
The Infobar can be added to printouts as well as to PS files. 
You can include information in three size variable fields (left, 
center, right), tokens are entirely supported. A preview func-
tion shows the result to be expected. To prevent the infobar 
from overlapping with document content, the document can 
be moved (to the top, the bottom, the right or  the left side of 
the document) and scaled. 

 The widthwidth of the three possible infobar areas can 
be defined using any of the following units of meaunits of mea--
surementsurement: point, millimeter, inch or percent. 

Setting up Output Jobs and Job Sets “Infobar” Options
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“Printjob Name” Options 
The dialog box for Printjob Name allows to setup a naming 
convention for internal PostScript names. By activating the 
checkbox Print Job Name for Print Queue, users can specify 
how the name should look like. 

The job name can either be the same as the output file or be 
determined through tokens. These can be used to evaluate 
information like date, time, document name, pagenumber, 
pagelabel etc. dynamically. 

 A description on how to use the token can be found 
in the Token HelpToken Help. 
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“PostScript Expert” Options 
In this area, PostScript output can be expanded via PostScript 
Snippets, which can be selected from pulldown menus. As 
the name suggests, PostScript Expert is intended for users 
who are familiar with PostScript. 

 An integrated Editor allows to create, modify and 
save PostScript Snippets. 
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Preflight 
This area contains the options needed to check for missing 
fonts and images, as well as to relink images. 

Check Usage of external External data Check Usage of external External data activating this option, 
MadeToPrint will check for images and fonts. MadeToPrint 
can update modified images and search for missing images in 
the folder next to the Quark document… 

…or MadeToPrint will start the  search in the parent folder. 

Setting up Output Jobs and Job Sets Preflight
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In case errors are detected, MadeToPrint can abort output, in-
dicate the error and demand user intervention or process the 
document nevertheless.  

In case of missing or modified imagesIn case of missing or modified images  the pop-up menu dis-
plays options, on how MadeToPrint can proceed in case im-
ages are missing or have been modified. 

• Do not process document (moves the document to the er-
ror folder) 

• Process document nevertheless (creates output despite 
error) 

• Ask user (processing stops and an error dialog indicates 
the problem) 

In case of missing fontsIn case of missing fonts  the pop-up menu provides the same 
options as with links. 

Create Text ReportCreate Text Report  MadeToPrint offers three different options 
for creating preflight error reports: 

• Only in case of error 
• Always 
• Never 

Setting up Output Jobs and Job Sets Preflight
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Script/Program 
Using the option Script/Program, scripts and applications can 
be addressed and started before and/or after executing a 
MadeToPrint Output Job. It is possible, for example, to run 
script loading the fonts before MadeToPrint starts processing. 

Setting up Output Jobs and Job Sets Script/Program
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“Batch” Option 
MadeToPrint offers a batch processing functionality, which 
will process all XPress documents located in a specific folder. 

Process FolderProcess Folder  activate the checkbox and select the folder 
with the XPress files to be processed. You can also process 
nested folders. Having finished batch processing MadeTo-
Print will create a report file in the selected batch folder. This 
report lists the processed files as well as the files that could 
not be processed. 

Setting up Output Jobs and Job Sets “Batch” Option
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Imposition Option 
With the Imposition function, you can output fully imposed 
PDF files. The preconfigured imposition schemes cover all 
common imposition tasks. 

To set up a Output Job (e.g. for imposition of business cards, 
 double-sided on one page) create a new Output Job and en-
ter a name under General (here: Business Card). 

In the Output area, as target select File (PDF). The Imposition 
function is not available for PostScript printing. If PostScript 
exists, you can use the Distiller to create a PDF file. 

Setting up Output Jobs and Job Sets Imposition Option

MadeToPrint for QuarkXPress Manual 34



Attention:Attention: For smooth operation, ensure that Single Page 
Output is deactivated in the Page area. 

Setting up Output Jobs and Job Sets Imposition Option
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Then, under Imposition activate the Imposition function and 
compile the required imposition scheme with the entries un-
der the Runlist and Sheet configuration categories. 

Setting up Output Jobs and Job Sets Imposition Option
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Here ensure that the number of pages in both categories 
matches. For the imposition of business cards, the specifica-
tions under Runlist: 8 business cards, double-sided and Sheet 
configuration: A4, 8 business cards are suitable. 

Setting up Output Jobs and Job Sets Imposition Option
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The configuration is now complete. Now save the Output 
Job. In the Run Mode the Business Card imposition specifica-
tion is now ready for processing layout documents. 

Setting up Output Jobs and Job Sets Imposition Option
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 If the supplied imposition scheme does not cover a 
task, you can adjust (knowledge of programming 
required) the settings file in a Script editor. The files 
are located in the following directories: 

Windows:Windows:  Program Files\Quark\QuarkX-
Press…\XTensions\MadeToPrint\pdfToolbox…\var\
Actions\Impose 
Mac OS:Mac OS: /Library/Application Support/Quark/
QuarkXPress…/XTensions/pdfToolbox…/var/Ac-
tions/Impose 

You can also contact us at support@axaio.comsupport@axaio.com. 
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Extended PDF test with “PDF Post 
Process” 
While MadeToPrint checks QuarkXPress files for errors with 
the Preflight  function presented above, with the PDF Post 
Process option PDF files can be checked in connection with 
the output for requirements defined before. 

In the PDF Post Process window, a Output Job is released for 
the subsequent test by clicking PDF Post Process. Some test 
profiles are already preconfigured, for example for digital 
printing (black-white and color) and for online publishing of 
PDF documents. If required, a text report can be created in 
various formats. You can also specify if you want errors in the 
PDF to be ignored by MadeToPrint. 

With the Manage Profiles button, the user can add more pro-
files that can be created using the callas pdfToolbox. Another 
option is to open the PDF generated by MadeToPrint in your 
default PDF viewer right after the finishing of the export. 

Setting up Output Jobs and Job Sets Extended PDF test with “PDF Post Process”
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Compiling a new Job Set 
To execute several Output Jobs together, MadeToPrint offers 
an option for compiling. You can create a new Job Set by us-
ing the icon shown below. 

Similar to Output Jobs, Job Sets should be annotated with a 
name. Also, they can be set to active and locked and be com-
pleted with a description. 

Under Referenced Output Jobs a popup menu lists up all 
available Output Jobs, by using the buttons Add and Remove 
Output Jobs can be appended to or deleted from the Job Set. 

Setting up Output Jobs and Job Sets Compiling a new Job Set
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Newly created Job Sets are then listed in Run Mode, but Job 
Sets cannot be used in batch-processing mode. 

Setting up Output Jobs and Job Sets Compiling a new Job Set
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The Run Mode with completed 
Output Jobs and Job Sets 
In Run Mode, all created Output Jobs and Job Sets are listed. 
Exception: deactivated Output Jobs or Job Sets do not ap-
pear in the overview. 

 Note: The input field for the number of copies is on-
ly active for the print output and not for the file 
output. 

The Run button runs the selected Output Job or Job Set. 

Setting up Output Jobs and Job Sets The Run Mode with completed Output Jobs and Job Sets
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How to setup hotfolder based 
processing 

 MadeToPrint Auto, available for Mac and Windows, 
is a plug-in for Adobe InDesign. The Auto function – 
already part of the Standard version requires and 
special license to be activated. 

MadeToPrint Auto provides exactly the same scope of func-
tionality as the Standard version supplemented by the option 
of processing documents through hot folders. The area Auto 
in the main dialog of MadeToPrint Auto has been designed to 
set up queues and to start the hot folder based processing. 

MadeToPrint XT Auto – Hotfolder based output How to setup hotfolder based processing
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 Using the MadeToPrint option Start MadeToPrint Start MadeToPrint 
Auto on Application StartupAuto on Application Startup in the Run Mode, en-
sures that MadeToPrint is ready for use right after 
system restart. 

MadeToPrint XT Auto – Hotfolder based output How to setup hotfolder based processing

MadeToPrint for QuarkXPress Manual 48



General 
Using the setup dialog Auto Jobs can be created, duplicated 
or deleted. 

Specify a name for each Auto Job and define whether the Au-
to Job is active and whether the queue is to be monitored au-
tomatically after starting MadeToPrint Auto. 

The Priority popup allows you to define up to five different 
priorities for the different hot folders. Jobs for archiving can 
thus be given a lower priority to ensure that more important 
PDF production jobs are completely finished first before us-
ing the processors for less important jobs. 

MadeToPrint XT Auto – Hotfolder based output General
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Action 
In this area, pre- and post-processing can be adjusted. 
MadeToPrint XT Auto can address scripts and other applica-
tions before or after processing QXP documents. Moreover, 
the Output Job (here Business Card) to be executed in Auto 
Mode is selected in the middle of this area. 

MadeToPrint XT Auto – Hotfolder based output Action
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Folder 
In this area, queues for Auto Jobs can be defined. IN (the fold-
er which is monitored constantly for incoming documents), 
OUT (where documents go which have been processed suc-
cessfully) and ERROR folder (for documents which could not 
be output) are necessary to process QXP documents. 

The Turbo… button will automatically create all necessary 
hotfolders. The Scan interval determines the time intervals 
for monitoring the queue. 

 Each Auto Job needs separate IN/OUT/ERROR fold-
ers, which can be located anywhere within a net-
work. There is no limitation regarding the number 
of process folders. 

MadeToPrint XT Auto – Hotfolder based output Folder
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Additional information 
• If you have licensed the standard version of MadeToPrint 

XT, you can use Auto version in the demo mode. 
• XPress files as well as Alias files (Mac) or Links (Windows) 

will be accepted and processed. Sub directories in the IN 
folder will not be monitored. We recommend to use Alias 
files, so you can leave the original file in place. 

• It is not possible to select the same IN folder for two Auto 
Jobs. Each Auto Job needs separate IN/OUT/ERROR fold-
ers. 

 If you have questions or helpful suggestions regard-
ing MadeToPrint, please send an e-mail to supsup--
port@axaio.comport@axaio.com. 
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Token Engine 

 MadeToPrint provides a powerful token engine that 
helps to define rules to generate file names, target 
directories – and a variety of status information for 
the job slug (infobar) dynamically. 

The tokens are accessible via pulldown menus under file 
name; infobar and other functionality areas of MadeToPrint. 
A description of each variable can be found in the token help. 

Rule-based Queries (Ask Token) 

With the help of so-called ASK-Tokens, it is possible to create 
queries, for example, to enable users to enter marks that will 
appear on the Infobar while executing a print job. The ASK to-
ken follows this syntax: 

«ASK( "Prompt", "Scope", "Format", "Error" )» «ASK( "Prompt", "Scope", "Format", "Error" )» 

The text entered underneath “Prompt” will be displayed as 
enter prompt in dialog window while executing a print job. 
The details under “Scope”, “Format”, and “Error” are optional 
and have the following meaning: 

The Area "Scope" The Area "Scope" 

"Scope""Scope" defines the time of the query. Values possible for 
“Scope” are “Job”, “Session” and “Page”. 

"Job""Job" – this query appears while executing a print job. This is 
a default setting and does not need to be given (entered). 

"Session""Session" – this query appears during each XPress session, 
i.e., you only need to enter your input after XPress has been 
restarted. 

"Page""Page" – this query appears on each page of the document to 
be output. 

The Area "Format" The Area "Format" 

Addendum Token Engine
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"Format""Format" is used to define, with the help of regular expres-
sions, rules (conditions) for the input, for example, 

"\\w" limits the input to alphanumeric values 

"\\d" limits the input to numerical values 

"\\d{6}" limits the input to a 6-digit number 

The Area "Error" The Area "Error" 

If the rule defined in “Format” does not match this, the fol-
lowing default error message will appear: This entry is not al-
lowed in the job settings. It is possible to individually adapt 
this preset error message by entering an entry in “Error”. 

Examples: Examples: 

The plain token «ASK(„Enter your name:“)» displays a dialog 
every time a print job is being executed. The entry is not lim-
ited, i.e., the user may enter any amount of characters in the 
query dialog. 

The advanced token «ASK(“Date of publication [DDM-
MJJ]:“,“Job“,“\\d{6}“,“Error, enter a date!“)» causes a query di-
alog to appear each time a print job is being executed. 

The entry is limited to six numerical values. Whenever the en-
try is incorrect, the message „Error, enter a date!“ will appear. 

Modifying the token in the area “Format“ will check the vali-
dation of the entered numerals while being entered. 

«ASK(„Date of publication [DDM-
MJJ]:“,“Job“,“([12][0-9]|3[01]|0[1-9])(0[1-9]|1[012])([0-9][0-9])“,“Er-
ror, enter a date!“)» 

The regular expression 
“([12][0-9]|3[01]|0[1-9])(0[1-9]|1[012])([0-9][0-9])“ describes 
the rules to enter day (01 to max. 31), month and year. 

([12][0-9]|3[01]|0[1-9]) describes the day (01 to max. 31) and 
allows only the numeral 1 or 2 in the first position, followed 
by the numerals 0 to 9. If the first numeral is 3, it shall only be 
followed by 0 or 1. If the first numeral is 0, then only numerals 
from 1 to 9 may follow. 

These rules are also defined for the month and year. 
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Page Numbers in File Names 

The token «PAGENUMBER( )« inserts the current page num-
ber, for example, into the file name. The token «PAGELABEL( 
)» may also be used here, however, instead of the total page 
numbers, the page marks will be used – defined in the sec-
tion options of QuarkXPress. In connection with the token 
«DOCUMENTNAME()», it is possible, for example, to define the 
following name conventions for the PostScript output: 

«PAGENUMBER()»_«DOCUMENTNAME()» «PAGENUMBER()»_«DOCUMENTNAME()» 

The outcome would be PDF files named 

1_Document.pdf 

2_Document.pdf 

3_Document.pdf 

... 

It is possible to create a three digit page number (beginning 
with zero) with the following token combination 

«RIGHT(00&PAGENUMBER(), 3 )»_«DOCUMENTNAME()» «RIGHT(00&PAGENUMBER(), 3 )»_«DOCUMENTNAME()» 

The token «RIGHT(00&PAGENUMBER(), 3 )» calculates from a 
string of text the defined amount of characters, in this case, 
beginning on the right. The string of text consists of double 
zero „00“ and the respective page number. The result would 
be 

001_Document.pdf 

002_Document.pdf 

003_Document.pdf 

... 

 If you have questions or if you need help regarding 
MadeToPrint, please contact: support@axaio.com support@axaio.com 

Addendum Token Engine
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Where does MadeToPrint XT store 
information 

Preferences folder 

MadeToPrint uses a preferences folder in the users prefer-
ences section to store data, e.g. a logfile and the MadeToPrint 
Output Jobs. 

This preferences folder is a separate folder for each XPress 
version. The folder can be found here: 

 

Windows Windows 

%APPDATA%\axaio software\Quark XPress …\MadeToPrint 
Plug-In 

macOS macOS 

Benutzername/Library/Preferences/axaio software/QuarkX-
Press …/MadeToPrint Plug-In 

 

MadeToPrint Output Jobs 

In the preferences folder mentioned above, MadeToPrint 
stores all Output Jobs, Auto Jobs. 

 

MTP_Settings.cfg 

This is a file in XML format, where MadeToPrint stores all Out-
put Jobs defined in the Standard section. 

 

MTPAutoSettings.cfg 

This is a file in XML format, where MadeToPrint stores all Auto 
Jobs defined in the Auto section. 
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If you see the error message "The version of the MadeToPrint 
Settings could be wrong. Please rename or delete the settings 
XML file." on MadeToPrint startup, it refers to those .cfg files. 

This might be caused by settings from a more recent MadeTo-
Print version, or the file got corrupted. You may fix the file by 
opening it in a plaintext editor and remove all illegal charac-
ters (e.g. "¿") in front of </prefs>. 

MadeToPrint Logfile 

MadeToPrint writes into a logfile that might help to find more 
information about an error. The logfile is called MadeToMadeTo--
Print.logPrint.log and is located in the MadeToPrint Preferences folder 
mentioned above in a subfolder called Logfiles. 

Once the logfile exceeds 10MB, it is moved to MadeTo-
Print_001.log (if this file already exists, it is deleted before) 
and a new MadeToPrint.log is written. This ensures to have 
the latest 10MB of logs available at all times, but also don't 
take too much disk space. 
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How do I update MadeToPrint XT and 
keep my settings 
When a new MadeToPrint version is released, it can be simply 
installed by running the installer. 

If the host application version1 is the same, the old version 
will be overwritten and settings will be kept. 

 Upgrading to a new host application version1 re-
quires a new license. If you have a valid Software 
Maintenance Agreement with us, you can get the li-
cense free of charge. 

MadeToPrint does store preferences in a folder that is explicit 
for the host application QuarkXPress and its version (e.g. 16 
for QuarkXPress 2020). See Where does MadeToPrint store in-
formation for more information. If you want to keep your 
preferences in the new version, you can simply copy the pref-
erences folder to the same place for the new version, e.g. 
copy the …/Library/Preferences/axaio software/QuarkXPress 
15/MadeToPrint Plug-In/Preferences nach …/Library/Prefer-
ences/axaio software/QuarkXPress 16/MadeToPrint Plug-In/
Preferences to copy the MadeToPrint Settings from MadeTo-
Print for QuarkXPress 2019 to MadeToPrint for QuarkXPress 
2020. 

1: e.g. from QuarkXPress 2018 (version 14) to QuarkXPress 
2019 (version 15); 
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